


Page 2 Features
■ Passed the University of New Hampshire Interoperability Lab (UNH) 10-Gbps 
Ethernet tests of MAC, 10GBASE-X physical coding sublayer (PCS), and physical 
medium attachment (PMA)

■ Verified and hardware tested with standard 10-Gbps Ethernet test equipment 

■ Flexible standard interfaces:

■ Seamless interface to commercial Ethernet PHY devices via 10-Gbps media 
independent interface (XGMII) or 10-Gbps attachment unit interface (XAUI)

■ Management data input/output (MDIO) master interface for PHY device 
management

■ 64-bit wide FIFO or no-FIFO interface to application logic based on the Avalon® 
Streaming (Avalon-ST) interface

f For more information on Avalon-ST and Avalon-MM interfaces, refer to 
the Avalon Interface Specifications.

■ 10-Gbps full-duplex throughput rate

■ Flow control by programmable pause quanta

■ Pause frame generation controllable by user applications, enabling flexible 
traffic flow control

■ Parameterizable FIFO size (64 bytes to 64 Kbytes) and programmable threshold 
levels

■ Programmable MAC addresses and receive packet filtering based on up to five 
unicast or multicast and broadcast destination MAC address, and one 
destination VLAN address

■ Programmable maximum receiving frame length up to 64 Kbytes, including jumbo 
frames (1,519 to 9,618 bytes)

■ Support for promiscuous (transparent) and non-promiscuous (filtered) operation

■ Support for virtual local area network (VLAN) and stacked VLAN tagged frames 
according to the IEEE 802.IQ standard

■ Management interface and loopback for system test—local or line loopback on the 
XGMII 

■ Statistics counters supporting RMON (RFC 2819), Ethernet type MIB (RFC 3635), 
and interface group MIB (RFC 2863) 

■ Filtering of frames with CRC errors, length-check error, or oversized errors 

■ Easy-to-use MegaWizard® interface for parameterization

■ IP functional simulation models for use in Altera-supported VHDL and Verilog 
HDL simulators

■ Verilog HDL and VHDL testbench or verification environment
10-Gbps Ethernet Reference Design © March 2009 Altera Corporation
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General Description
The 10-Gbps Ethernet reference design provides an integrated Ethernet MAC, PCS, 
and PMA solution for Ethernet applications. The reference design works in full-
duplex mode and supports both switching and network interface card (NIC) or line-
card applications, by providing transparent and full Ethernet frame termination and 
generation. 

Figure 1 shows the 10-Gbps Ethernet reference design block diagram. The function 
comprises the following main blocks: MAC and PCS. All blocks are parameterizable 
at synthesis time. A memory-mapped register interface controls the MAC and PCS 
blocks. 

1 You can implement a MAC only function or implement the optional XAUI in soft 
logic in Stratix IV devices.

For the local interface, the reference design provides standard Avalon-ST interfaces, to 
allow interoperability with other Avalon-ST components. A host processor can 
manage the reference design via a separate Avalon Memory-Mapped (Avalon-MM) 
interface that provides access to the control register space. For the PHY interface, the 
reference design can seamlessly connect to any industry standard 10-Gb Ethernet 
PHY or MAC device via XGMII or XAUI. The XAUI is only available in Altera devices 
that have serial transceivers.

f For more information on the Avalon-ST interface, refer to the Avalon Interface 
Specifications.

Figure 2 shows an example application using the reference design as a stand-alone 
MAC without the PCS and PMA, serving as a bridge between the user application 
and external (industry-standard) Ethernet PHY devices. 

Figure 1. Block Diagram

Note to Figure 1:

(1) You can implement the optional XAUI in an Altera device transceiver or as soft logic, which gives a soft 10GBASE-X XAUI PCS.

10-Gbps
Ethernet MAC

Local (Avalon-ST)
Interface

Host (Avalon-MM)
Interface

PCS
XGMII XAUI

10-Gbps Ethernet Reference Design

Optional (Note 1) 

PMA PHY Device 
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Verification
Altera verified the 10-Gbps Ethernet reference design through extensive in-house 
simulation and internal hardware verification. 

Altera used a highly parameterizeable transaction-based testbench to test the 
following aspects of the reference design:

■ Register access

■ Management data input and output (MDIO) access

■ Frame transmission and error handling

■ Frame reception and error handling

■ Received ethernet frame MAC address filtering

■ Flow control

Altera has also validated the reference design with copper and optical media using 
the Spirent SmartBits and the following Altera development boards:

■ Stratix II GX video development board

■ Stratix II GX PCI Express development board

In the copper medium, Altera tested the reference design with an external 10GBASE-
CX4 PHY device, a CX4 switch and CX4 test equipment; in the optical medium, Altera 
tested the 10-Gbps Ethernet reference design with a 10-Gbps X2 PHY board and 
various X2 optical pluggable modules interfacing to standard test equipment. 

f For more information on X2, refer to www.X2msa.org.

For hardware testing, a 10-Gbps Ethernet MAC, PCS, PMA, and an internal system 
design are implemented in the FPGA. The internal system retrieves all frames 
received from the test equipment by the MAC function and returns them to the sender 
by manipulating the address fields, implementing a loopback at the internal system 
interface of the MAC. 

Figure 2. Stand-Alone 10-Gbps Ethernet MAC
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Performance and Resource Utilization
Table 3 shows the typical expected performance for different parameters, using the 
Quartus® II software version 9.0 targeting a Stratix II GX (EP2SGX30DF780C3) device.

For C4 and C5 device speed grades the fMAX is 156.25 MHz.

Table 4 shows the typical expected performance, using the Quartus II software v9.0 
targeting a Stratix IV (EP4SGX70DF29C3) device.

Table 5 shows the typical expected performance, using the Quartus II software v9.0 
targeting a Arria GX (EP1AGX20CF780C6) device.

Installation and Licensing
To install the reference design, unzip the .tar.gz file to a directory on your PC. 

1 Do not unzip to the standard Altera IP directory altera\<version>\ip.

In the Quartus II software add the 10-Gbps Ethernet library to the user library:

1. On the Tools menu click Options.

2. Click Global User Libraries.

Table 3. 10-Gbps Ethernet Performance and Resource Utilization—Stratix II GX Device

XAUI

FIFO 
(eight-
byte 

words) MDIO
Statistics 
Counter

Combinational
ALUTs

Logic 
Registers

fMAX (MHz) Memory

Avalon-
MM

Avalon-
ST

System 
Clock M4K M512

Yes 64 Yes Yes 4,141 3,759 144 200 183 9 13

Yes 64 Yes No 3,348 2,962 150 200 183 8 3

Yes 64 No No 3,300 2,828 150 200 183 8 3

Yes No No No 2,973 2,509 150 200 171 4 3

Table 4. 10-Gbps Ethernet Performance and Resource Utilization—Stratix IV Device

XAUI

FIFO 
(eight-
byte 

words) MDIO
Statistics 
Counter

Combinational
ALUTs

Logic 
Registers

fMAX (MHz) Memory

Avalon-
MM

Avalon-
ST

System 
Clock M9K

Yes 64 Yes Yes 4,148 3,787 142 200 179 16

Soft XAUI only — 2,738 2,098 156.25 6

MAC and soft 
XAUI

128 Yes Yes 7,761 6,874 177 208 156.25 16

Table 5. 10-Gbps Ethernet Performance and Resource Utilization—Arria GX Device

XAUI

FIFO 
(eight-
byte 

words) MDIO
Statistics 
Counter

Combinational
ALUTs

Logic 
Registers

fMAX (MHz) Memory

Avalon-
MM

Avalon-
ST

System 
Clock M4K M512

Yes 64 Yes Yes 4,218 3,785 120 160 156.25 11 13
© March 2009 Altera Corporation 10-Gbps Ethernet Reference Design
Preliminary



Page 6 Getting Started
3. In Library Name specify the eth_10g\lib directory.

After you purchase a license for the reference design, you can request a license file 
from the Altera website at www.altera.com/licensing and install it on your computer. 
When you request a license file, Altera emails you a license.dat file. If you do not have 
Internet access, contact your local Altera representative.

Getting Started
Figure 3 shows the stages for creating a system with the 10-Gbps Ethernet reference 
design and the Quartus II software. Each of the stages is described in detail in 
subsequent sections.

Design Flow Selection
You customize the 10-Gbps Ethernet reference design by specifying parameters using 
the 10-Gbps Ethernet MegaWizard interface, launched from either the MegaWizard 
Plug-in Manager or SOPC Builder in the Quartus II software.

Figure 3. 10-Gbps Ethernet Design Flow

Specify Parameters
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SOPC Builder
Flow

Compile the 
Example Design

Program Device
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MegaWizard Plug-in Manager Flow
Use the MegaWizard Plug-in Manager flow to create a variant that you can instantiate 
manually in your design. 

SOPC Builder Flow
Use the SOPC Builder flow for the following advantages:

■ You want to rapidly create a new SOPC Builder system design that includes an 
Ethernet interface. 

■ You want to use the reference design in conjunction with other components 
available in SOPC Builder such as the Nios II processor, external memory 
controllers and the scatter-gather DMA controller.

MegaWizard Plug-in Manager Flow
The MegaWizard Plug-in Manager flow allows you to customize the 10-Gbps 
Ethernet reference design, and manually integrate the function into your design.

Specify Parameters
Follow the steps below to specify 10-Gbps Ethernet parameters using the 
MegaWizard Plug-in Manager flow.

1. Create a Quartus II project using the New Project Wizard available from the File 
menu.

2. Launch MegaWizard Plug-in Manager from the Tools menu, and follow the 
prompts in the MegaWizard Plug-in Manager interface to create a custom 
megafunction variation.

1 You can find 10-Gbps Ethernet by expanding Installed Plug-Ins > 
Interfaces > Ethernet.

3. Specify the parameters on all pages in the Parameter Settings tab.

For detailed explanation of the parameters, refer to the “Parameter Settings” on 
page 10.

4. On the EDA tab, turn on Generate simulation model to generate an IP functional 
simulation model for the reference design in the selected language. 

An IP functional simulation model is a cycle-accurate VHDL or Verilog HDL 
model produced by the Quartus II software.

1 Some third-party synthesis tools can use a netlist that contains only the 
structure of the reference design, but not detailed logic, to optimize 
performance of the design that contains the reference design. If your 
synthesis tool supports this feature, turn on Generate netlist.

c Use the simulation models only for simulation and not for synthesis or any 
other purposes. Using these models for synthesis creates a non-functional 
design.
© March 2009 Altera Corporation 10-Gbps Ethernet Reference Design
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Page 8 Getting Started
5. On the Summary tab, select the files you want to generate. A grey checkmark 
indicates a file that is automatically generated. All other files are optional.

6. Click Finish to generate the reference design and supporting files. 

Simulate with Provided Testbench
You can simulate the reference design using the IP functional simulation model and 
testbench generated by the 10-Gbps Ethernet wizard. 

f For more information on the testbench, see “Testbench” on page 56.

To run a simulation using the ModelSim simulator, follow these steps:

1. Start the ModelSim simulator.

2. Change the working directory to <project directory>\tb\verilog or <project 
directory>\tb\vhdl.

3. Run the following command to set up the required libraries, compile the 
generated IP functional simulation model, and exercise the simulation model with 
the provided testbench:

demo_run_modelsim.tclr
The ModelSim transcript pane (in Main window) displays messages from the 
testbench reflecting the current task being performed.

Instantiate the Reference Design in your Design
You can now integrate your 10-Gbps Ethernet reference design variation into your 
design, and simulate the system with your custom testbench.

SOPC Builder Flow
The SOPC Builder flow allows you to add the reference design directly to a new or 
existing SOPC Builder system. You can also easily add other available components to 
quickly create an SOPC Builder system with an Ethernet interface, such as the Nios II 
processor, external memory controllers and scatter-gather DMA controllers. SOPC 
Builder automatically creates the system interconnect logic and system simulation 
environment.

f For more information on SOPC Builder, refer to Volume 4 of the Quartus II Handbook.

Specify Parameters
Follow the steps below to specify 10-Gbps Ethernet parameters using the SOPC 
Builder flow.

1. Create a new Quartus II project using the New Project Wizard available from the 
File menu.

2. Launch SOPC Builder from the Tools menu.

3. For a new system, specify the system name and language.
10-Gbps Ethernet Reference Design © March 2009 Altera Corporation
Preliminary

http://www.altera.com/literature/hb/qts/qts_qii5v4.pdf


Getting Started Page 9
4. Add the reference design to the SOPC Builder component list:

a. On the Tools menu, click Options.

b. In the Category list click IP Search Path.

c. Click Add.

d. Add the <path>eth_10g\lib\ip_toolbench.

e. Click Finish.

f. On the File menu, click Refresh Component List.

5. Add 10-Gbps Ethernet to your system from the System Contents tab. 

1 You can find 10-Gbps Ethernet by expanding Interface Protocols > Ethernet. 

6. Specify the required parameters on all pages in the Parameter Settings tab.

f For detailed explanation of the parameters, refer to the “Parameter 
Settings” on page 10.

7. Click Finish to complete the reference design and add it to the system. 

Complete the SOPC Builder System
Follow the steps below to complete the SOPC Builder system.

1. Add and parameterize any additional components to the system.

1 A typical SOPC builder system that enables Ethernet connectivity uses a 
scatter-gather DMA controller on each of the transmit and receive paths, 
and a Nios II processor for configuration and control. 

2. Connect the components using the SOPC Builder patch panel.

3. If you intend to simulate your SOPC builder system, select Simulate on the 
System Generation tab to generate a functional simulation model for the system.

4. Click Generate to generate the system.

Simulate the System
During system generation, SOPC Builder optionally generates a simulation model 
and testbench for the entire system which you can use to easily simulate your system 
in any of Altera's supported simulation tools. SOPC Builder also generates a set of 
ModelSim Tcl scripts and macros that you can use to compile the testbench, IP 
Functional simulation models and plain-text RTL design files that describe your 
system in the ModelSim simulation software.

f For more information about simulating SOPC Builder systems, refer to Volume 4 of the 
Quartus II Handbook and AN 351: Simulating Nios II Systems.
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Page 10 Parameter Settings
Design Compilation and Device Programming
You can use the Quartus II software to compile your design. After a successful 
compilation, you can program the targeted Altera device and verify the design in 
hardware.

f For more information on compiling a design and programming Altera devices, refer 
to Quartus II Help.

Parameter Settings
This section describes the parameters and how they affect the behavior of the 
reference design. Each section corresponds to a page in the Parameter Settings tab in 
the 10-Gbps Ethernet MegaWizard interface.

1 When parameterizing a reference design using the SOPC Builder flow, the EDA and 
Summary tabs are not visible. In the SOPC Builder flow, simulation model settings are 
inherited from options specified in SOPC Builder. 

f For more information on setting simulation options, refer to the Quartus II Help.

Figure 4. Options
10-Gbps Ethernet Reference Design © March 2009 Altera Corporation
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Variation
Select MAC + XGMII, MAC + XAUI, MAC only, Soft XAUI only, or MAC + soft 
XAUI. XGMII is a 32-bit double data rate interface at 156.25 MHz with four bits of 
control; XAUI is a four-lane serialized interface at 3.125 Gbps per lane. The XAUI is 
only available in Altera devices with a minimum of four integrated serial transceivers. 
The Soft XAUI only and MAC + soft XAUI options allow your design to use spare 
transceivers in Stratix IV devices.

The soft XAUI is only available on Stratix IV devices and replicates the functionality 
of the XAUI PCS that is available in most transceivers. It allows the design to use up 
all of the available transceivers.

The soft PCS is a direct replacement of the ALTGXB megafunction, where the resets’ 
generation is embedded and the soft PCS has additional status pins.

Soft XAUI Tx PLL Type
When you select MAC + soft XAUI or Soft XAUI only, you can select the soft XAUI 
Tx PLL type—either CMU or ATX.

For more information on CMU or ATX, refer to the Stratix IV Transceiver Architecture 
chapter in the Stratix IV Device Handbook.

FIFO Options
Turn on Include Avalon Streaming FIFO Buffer to include a FIFO buffer in the local 
interface. 

Select the receiver and transmitter FIFO size. FIFO size options are: 8, 64, 128, 256, 
512, 1,024, 2,048, 4,096, or 8,192 eight-byte words.

1 The usable FIFO size is (wizard size – 1). For example, if you select a FIFO size of 128 
eight-byte words, the size you can use is 127 eight-byte words.

Select Fill level (cut-through mode) and the read data available (avl_st_rx_dav) 
signal goes high when a threshold is reached or an end of packet (EOP). The fill level 
is passed continuously from the write side to the read side.

Select Store forward and the packet information is passed from the write side to the 
read side only when the EOP is reached on the write side. So data available only 
triggers on EOP. When you select Store forward, select the FIFO size to hold the 
longest possible frame in the system. Altera recommends twice the maximum 
possible frame size.

f For more information on thresholds, see “Receiver FIFO Thresholds” on page 18 and 
“Transmitter FIFO Thresholds” on page 22.

1 If you turn off Include Avalon Streaming FIFO, for the receiver there is no ready 
signal, so the data is sent automatically; for the transmitter, the read latency is 1. You 
must provide a full packet when the design indicates data is present.
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MAC Options
Turn on Enable MDIO, so the reference design instantiates an MDIO master, see 
“MDIO Interface” on page 30.

Turn on Enable Statistics Counter to allow reporting of statistics transmitted and 
received.

Enter a number for the Customer version number, see rev bit in Table 15 on page 36.

Transceiver Reconfiguration Options
For Stratix II GX devices with XAUI, if you turn on Use external reconfiguration 
block, you can modify analog properties of the transceiver with an external 
reconfiguration block (ALT2GXB_RECONFIG). For Stratix IV or Arria II GX devices 
with XAUI, you must have an external reconfiguration block, so this option is always 
on. For Arria GX devices, this option is not available.

1 If you select this option, you must generate and use an external reconfiguration block. 
The external configuration block is an ALT2GXB_RECONFIG megafunction that you 
can edit and generate in the Quartus II software.

f For more information on the ALT2GXB_RECONFIG megafunction, refer to the 
ALT2GXB_RECONFIG Megafunction User Guide.

In addition, when you turn on Use external reconfiguration block, you can select the 
starting channel number of the transceivers.

f For more information on starting channel number, refer to the ALT2GXB_RECONFIG 
Megafunction User Guide.

Table 6 shows the reconfiguration block signals.

Functional Description
The 10-Gbps Ethernet reference design provides an Avalon® Streaming (Avalon-ST) 
interface to user applications and an industry standard XGMII or XAUI to external 
PHY devices. 

Figure 5 shows a block diagram of the 10-Gbps Ethernet reference design.

Table 6. External Reconfiguration Block Signals

Signal

Size (Bits)

DirectionStratix II GX Devices Stratix IV Devices

reconfig_fromgxb 1 17 Output

reconfig_togxb 3 4 Input

reconfig_clk 1 1 Input
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Frame Format
A basic IEEE 802.3 Ethernet frame comprises the following fields:

■ Start—1 byte.

■ Preamble—6 bytes.

■ Start frame delimiter (SFD)—a 1-byte fixed value of 0xD5 which marks the 
beginning of a frame.

■ Destination and source addresses—6 bytes each. The least significant byte is 
transmitted first.

■ Length or type—a 2-byte value equal to or greater than 1,536 (0x600) indicates a 
type field. Otherwise, this field contains the length of the payload data. The most 
significant byte of this field is transmitted first on the serial line to the Ethernet 
network.

■ Payload data and pad—variable length data and padding of 00 data if frame 
length is less than 64 bytes long.

■ Frame check sequence (FCS )—a 4-byte cyclical redundancy check (CRC) value for 
detecting frame errors during transmission.

■ End of frame delimiter (EFD)

Figure 6 shows the format of a basic frame.

Figure 5. Block Diagram
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The extension of a basic frame is a virtual local area network (VLAN) tagged frame, 
which contains an additional 4-byte field for the VLAN tag and information between 
the source address and length/type fields. VLAN tagging is defined by the IEEE 
802.1Q standard. VLANs can identify and separate many groups' network traffic from 
each other in enterprises and also in metro networks. Each VLAN group can consist of 
many users with varied MAC address in different geographical locations of a 
network. VLANs increase and scale the network performance and add privacy and 
safety to various groups or customers’ network traffic. 

VLAN tagged frames have a maximum length of 1,522 bytes, excluding the preamble 
and the SFD bytes. Figure 7 shows the format of a VLAN tagged frame.

In some applications, frames can be tagged with two consecutive VLAN tags (stacked 
VLAN). Stacked VLAN frames contain an additional 8-byte field between the source 
address and client length/type fields, see Figure 8. Stacked VLANs allow virtual 
private networks (VPN) in metro Ethernet and across multiple carriers. 

Figure 6. Frame Format

Figure 7. VLAN Tagged Frame Format
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f For pause frame format, refer to Figure 14 on page 26.

Receiver Operation
This section describes the receiver operation. Figure 9 shows the flow of the receiver 
operation.

Preamble Processing
The preamble sequence is Start, six preamble bytes, and SFD. If this sequence is 
incorrect the frame is ignored. The Start word must be on the receiving lane 0 (most 
significant byte).

Figure 8. Stacked VLAN Tagged Frame Format
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The reference design uses the SFD byte (0xD5) to identify the last byte of the 
preamble. The reference design looks for the Start, 6 preambles and SFD. If not found 
the frame is ignored.

The IEEE standard specifies that frames must be separated by an interframe gap (IFG) 
of an average of 96 bit times. 

The reference design removes all preamble and SFD bytes from accepted frames.

Address Checking
Bit 0 in the destination address field specifies the type of address. 

■ If bit 0 is 0, the destination address is a unicast (individual) address.

■ If bit 0 is 1, the destination address defines a multicast (group) address.

■ If all 48 bits in the destination address are 1, it is a broadcast address.

The reference design accepts broadcast frames if bit 28 (BROAD_FILTER_ENA) in the 
command_config register is set to 0, which is the default. If you enable promiscuous 
operation (PROMIS_EN bit in the command_config register = 1), address checking is 
omitted and all received frames are accepted. 

A frame is accepted only if its unicast destination address matches any of the 
following addresses:

■ The primary address, configured in the registers mac_0 and mac_1—these 32-bit 
registers build a 48-bit MAC address

■ The four supplemental addresses, configured in the following registers: 
smac_0_0 and smac_0_1, smac_1_0 and smac_1_1, and smac_2_0 and 
smac_2_1, and smac_3_0 and smac_3_1

Otherwise, the reference design discards the frame. The multicast address matching 
works the same way as the unicast. If the supplemental address is multicast, it is 
matched. For more information on the address registers, refer to Table 15 on page 36.

Frame Length/Type Checking
If the length/type field represents the payload length, the reference design checks the 
payload length and reports any error in the frame status, avl_st_rx_err. 
Otherwise, the reference design forwards the frame to your application. The frame is 
forwarded even with the error except if filtered by the FIFO.

The maximum frame size is defined in a register, the value of the register determines 
the maximum length. The maximum frame size is 64 Kbyte. If the maximum frame 
size is exceeded, the packet is marked as error, and the error signal is set high.

1 Although the MAC supports maximum frame size of 64 Kbyte, the PCS is only rated 
to support 16 Kbyte frames with a clock tolerance of +/– 100 ppm, as defined in the 
IEEE 802.3 specification. To allow the PCS to run frames up to 64 Kbytes, the clocks  
must be of identical frequency (0-ppm difference) and must originate from the same 
clock.
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VLAN Frame Processing

A value of 0x8100 in the length/type field denotes a VLAN tagged frame. A 2-byte 
VLAN tag follows the length/type field. VLAN tagged frames are received in the 
same manner as basic frames, and the entire frame, including the VLAN tag, is 
forwarded to the user application. The reference design sets the avl_st_vlan_tag 
signal to indicate that the current frame is a VLAN tagged frame.

The reference design removes the padding from VLAN tagged frames only when the 
value of the client length/type field, which comes after the VLAN control information 
field, is less than 42 and the PAD_EN bit in the command_config register is set to 1.

Stacked VLAN Frame Processing

A value of 0x8100 in the length/type field following the additional 2 bytes in VLAN 
tagged frames denotes a stacked VLAN tagged frame (see “Frame Format” on 
page 13). The reference design sets the avl_st_vlan_vlan_tag signal to indicate 
that the current frame is a stacked VLAN tagged frame.

The reference design removes the padding from stacked VLAN tagged frames only 
when the value of the client length/type field, which comes after the second VLAN 
tag field, is less than 38 and the PAD_EN bit in the command_config register is set to 
1.

Pause Frame Termination

Pause frames are terminated within the receive engine; they are not forwarded to the 
receive FIFO. The reference design determines if a pause frame is valid by checking its 
CRC and frame length. The pause quanta in a valid pause frame is extracted and 
forwarded to the transmit engine. Invalid pause frames are ignored.

1 For the destination address, both the multicast and the unicast are taken. The frame 
must be valid, and be at least 64 bytes long and have a correct CRC.

The statistics counter aPAUSEMACCtrlFramesReceive is incremented each time a 
valid pause frame is received.

Payload Pad Removal
The padding removal can be optional, depending on the payload length and the value 
of the PAD_EN bit in the command_config register.

The reference design removes the padding, prior to sending the frames to the receive 
FIFO, when the PAD_EN bit is set to 1 and the payload length is less than the following 
values for the different frame types:

■ 46 bytes for basic frames

■ 42 bytes for VLAN tagged frames

■ 38 bytes for stacked VLAN tagged frames

If the PAD_EN bit is set to 0, complete frames including the padding are forwarded to 
the receive FIFO.

CRC Checking
The following equation shows the CRC polynomial, as specified in IEEE 802.3:
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FCS(X) = X 32 +X 26 +X 23 +X 22 +X 16 +X 12 +X 11 +X 10 +X 8 +X 7 +X 5 +X 4 +X 
2 +X 1 +1

The 32-bit CRC value occupies the FCS field with X32 in the least significant bit of the 
first byte. The CRC bits are thus received in the following order: X32, X30,..., X1, X0.

If a CRC-32 error is detected, the reference design marks the frame invalid by setting 
the frame status, avl_st_rx_err, to 1. 

The CRC-32 field is forwarded to the receive FIFO if the CRC_FWD and PAD_EN bits in 
the command_config register are 1 and 0 respectively. 

Frame Length Checking
The reference design checks the complete frame length to ensure that the length 
conforms to the following conditions:

■ The length of all frame types is not less than 64 bytes.

■ The length of basic frames is not greater than the maximum length specified in the 
frm_length register.

■ The length of VLAN tagged frames is not greater than the maximum length 
specified in the frm_length register plus four.

■ The length of stacked VLAN tagged frames is not greater than the maximum 
length specified in the frm_length register plus eight.

The reference design keeps track of the actual frame payload length as it receives a 
frame. The actual frame payload length is checked against the length/type or client 
length/type field, depending on the frame type, when the NO_LGTH_CHECK bit in the 
command_config register is set to 0 and a valid frame length is received for the 
following frame types:

■ Basic frames—the length/type field is between 0x2E and 0x0600 (46 to 1,536), 
excluding 0x600.

■ VLAN tagged frames—the client length/type field is between 0x2A and 0x0600 
(42 to 1,536), excluding 0x600.

■ Stacked VLAN tagged frames—the client length/type field is between 0x26 and 
0x0600 (38 to 1,536), excluding 0x600.

If the actual frame payload length and frame length received do not match, the 
reference design sets the received frame status bit avl_st_rx_err to 1, indicating a 
length error. 

Receiver FIFO Thresholds
If you turn on Include Avalon Streaming FIFO in the wizard, you can configure the 
following receiver FIFO thresholds to dynamically change the receive FIFO 
operations and effectively manage potential FIFO overflow or underflow:

■ Almost full off

■ Almost full on

■ Almost empty off

■ Almost empty on
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The FIFO is 64 bits wide. All the thresholds are in bytes (8 bits). Figure 10 illustrates 
the receiver FIFO thresholds.

You set the receive FIFO thresholds via registers. Table 7 describes how each threshold 
can be used to change and manage FIFO operations.

1 When the FIFO buffer has N 8-byte entries, the minimum value is 0; maximum value 
is (N – 1). The on and off values must be different.

1 If you turn off the Include Avalon Streaming FIFO for the receiver there is no ready 
signal, so the data is sent automatically.

Figure 10. Receiver FIFO Thresholds
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dav = 0

dav = 1

Almost Full On

Receiver FIFO Level

Almost Empty On

dav = 0

dav = 1

Almost Empty Off

Transmitter FIFO Level

Table 7. Receive Threshold Registers Description

Threshold Register Name Description

Almost full off rx_almost_full_
off

The number of unread entries in the FIFO before the FIFO is empty. When 
the FIFO reaches this level, user_rx_dav is asserted.

Almost full on rx_almost_full_
on

The number of unwritten entries in the FIFO before the FIFO is full. When 
the FIFO reaches this level, user_rx_dav is deasserted.

Almost empty off rx_almost_empty_
off

Indicates that there are enough entries to read. When the FIFO reaches this 
level, avl_st_rx_dav is asserted.

Almost empty on rx_almost_empty_
on

Indicates that there are insufficient entries in the FIFO for the user 
application to start reading from it. When the FIFO reaches this level, 
avl_st_rx_dav is deasserted unless an EOP is present in the FIFO.
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Link Fault Signaling
The receiver monitors the traffic for local and remote fault signaling. On receiving 
these faults, it requests the transmission of remote fault or idles respectively. On 
detection of local or remote faults, the receiver transmits remote fault or idle, which 
overrides the sent data.

The state machine for detecting and transmitting follows IEEE 802.3 Clause 46 state 
diagram.

Transmitter Operation 
Frame transmission starts when the transmit FIFO buffer holds enough data and 
initiates the following tasks:

■ Generates Start, preamble, and SFD field before frame transmission

■ Inserts source address if required

■ Adds padding to the frame, if required 

■ Calculates and appends CRC-32 to the transmitted frame, if required

■ Sends frame with correct interframe gap (IFG)

■ Generates XOFF pause frames if the receive FIFO reports a congestion, if the 
xoff_gen signal is asserted, or if xoff_request signal is asserted (pulsed) 

■ Generates XON pause frames if the receive FIFO congestion condition is cleared, if 
the xon_gen signal is asserted, or if xon_request signal is asserted (pulsed) 

■ Suspends Ethernet frame transmission (XOFF) if a non-zero pause quanta is 
received from the receive path

■ Checks and generates the link fault condition

f For more information on XON and XOFF pause frames, see “Flow Control Operation” 
on page 24.

Figure 11 shows the transmitter flow. 
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Address Insertion
If address insertion is enabled (TX_ADDR_INS bit in the command_config register = 
1), the source address in frames received from the transmit FIFO is replaced with the 
primary address. 

If address insertion is disabled (TX_ADDR_INS bit in the command_config register = 
0), the source address is forwarded to the Ethernet-side interface.

Frame Payload Padding
IEEE 802.3 defines a minimum frame length of 64 bytes. To avoid violating this 
specification, the reference design automatically inserts padding bytes (0x00) if it 
receives frames with payload length less than 46 bytes from the user application:

CRC-32 Generation
The CRC polynomial, as specified in the IEEE 802.3, is shown in the following 
equation:

FCS(X) = X 32 +X 26 +X 23 +X 22 +X 16 +X 12 +X 11 +X 10 +X 8 +X 7 +X 5 +X 4 +X 
2 +X 1 +1

Figure 11. Transmitter Flow
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The 32-bit CRC value occupies the FCS field with X31 in the least significant bit of the 
first byte. The CRC bits are thus transmitted in the following order: X31, X30,..., X1, X0.

IFG
The IFG configured in the tx_ipg_length register is maintained between 
transmissions. The minimum IFG can be configured to any value between 64 and 216 
bit times, where 64 bit times is the time it takes to transmit 64 bits of raw data on the 
medium.

The deficit idle counter maintains an average IFG. You can configure the average IFG 
value in the tx_ipg_length register (0x05c). The number is a multiple of 4 with a 
minimum of 8 and a maximum of 252. The default (IEEE required value) is 12. In the 
traffic, the IFG varies between (IFG value–3) and (IFG value+3) depending on the 
deficit idle counter.

Transmitter FIFO Thresholds
You can configure the following transmitter FIFO thresholds to dynamically change 
the transmitter FIFO operation and effectively manage potential FIFO overflow or 
underflow: 

■ Almost full off

■ Almost full on

■ Almost empty off

■ Almost empty on

The FIFO is 64 bits wide. All the thresholds are in bytes (8 bits). Figure 12 illustrates 
the transmitter thresholds.

Figure 12. Transmitter FIFO Thresholds
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The transmitter FIFO thresholds are configured via the registers. Table 8 describes 
how you can use each threshold to change and manage FIFO operations.

1 When the FIFO buffer has N 8-byte entries, the minimum value is 0; maximum value 
is (N – 1). The on and off values must be different.

1 If you turn off the Include Avalon Streaming FIFO for the transmitter, the read 
latency is 1. You must provide a full packet when the design indicates data is present.

Transmit FIFO Underflow
During a frame transmission, if the transmit FIFO reaches the almost-empty threshold 
with no end of frame indication stored in the FIFO, the transmit control stops reading 
data from the FIFO and initiates the following actions:

1. The reference design indicates that the fragment transferred is not valid.

2. The reference design terminates the frame transmission. 

3. After the underflow, the application completes the frame transmission.

4. The transmit control discards any new data in the FIFO until the EOP is reached. 

5. The reference design starts to transfer data on the XGMII when the application 
sends a new frame with a start of frame indication.

Errors
The transmitter and receiver allow errors. The reference design reports the error and 
acts to recover from an incoming or reported error. 

From the Ethernet stream, you can have a command character error |E|, if for 
example there is a disparity error. From the Avalon-ST interface, you can trigger an 
error on the error pin alongside the data. 

On the transmit side, if the data runs dry on the input side without an EOP, an error is 
sent out to the PCS and Ethernet network and the reference design pulls data from the 
internal system until the EOP is read. If an error signal arrives alongside the data, the 
reference design ensures the error is propagated. In the transmitter, a FIFO underflow 
triggers an error (reading incorrect data). The transmitter state machine recovers from 
this condition. The transmitter errors the frame (transmits the error control character 
|E|) in the following cases:

Table 8. Threshold Registers Description

Threshold Register Name Description

Almost full off tx_almost_full_off The number of unread entries in the FIFO before the FIFO is empty. When 
the FIFO reaches this level, avl_st_tx_dav is deasserted.

Almost full on tx_almost_full_on The number of unwritten entries in the FIFO before the FIFO is full. When 
the FIFO reaches this level, avl_st_tx_dav is asserted.

Almost empty off tx_almost_empty_off Indicates that there are enough entries to read. When the FIFO reaches 
this level, user_tx_dav is asserted.

Almost empty on tx_almost_empty_on Indicates that there are insufficient entries in the FIFO for the user 
application to start reading from it. When the FIFO reaches this level, 
user_tx_dav is deasserted unless there is another EOP in the FIFO.
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